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Preface

Thank you for purchasing a Canon Document Scanner.

CapturePerfect 3.1 is an ISIS-compatible application program that enables the computer to acquire 
images from the Canon Document Scanner. To fully understand the CapturePerfect 3.1 functions and to 
be able to use them effectively, please read this guide and the ISIS/TWAIN Driver Help guide as well as 
your scanner's operating manual.

About Trademarks
• ISISTM and MultiStreamTM are trademarks of EMC Corporation.

• Microsoft, Windows, SharePoint, PowerPoint, and Windows Live are registered trademarks of Microsoft 
Corporation in the United States and are trademarks or registered trademarks of Microsoft Corporation in 
other countries.

• Product names mentioned herein are for identification purposes only and may be trademarks and/or 
registered trademarks of their respective companies.

• TM and ® are not set forth in this manual.

Copyright
• libtiffs

Copyright (c) 1988-1996 Sam Leffler
Copyright (c) 1991-1996 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose 
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice 
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and 
Silicon Graphics may not be used in any advertising or publicity relating to the software without the 
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, 
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT 
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

• libjpeg
Portions of this software are based in part on the work of the Independent JPEG Group.

Reproduction Warning
• Reproduction of documents such as the following is illegal and subject to penalty: paper currency and 

other legal tender, valuable instruments and passports issued by a government, as well as licenses, 
certificates, permits, official documents, and private records issued by a public or private entity.

• Reproduction of copyrighted materials, such as documentation, pictures, imprints, maps, and illustrations, 
for purposes other than personal use is prohibited.
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Disclaimer
• Reproduction of the contents of this guide, in part or in whole, without prior permission is prohibited. 

• This guide is subject to change without notice.

• Every effort has been made to ensure the accuracy of the information in this guide. However, Canon 
Electronics Inc. and its subsidiaries assume no responsibility for any errors or their consequences.

Copyright © 2006   CANON ELECTRONICS INC. ALL RIGHTS RESERVED
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Before Using

Please read the following descriptions before using CapturePerfect.

• About the CapturePerfect Window (→P. 6) : Describes the menus in the CapturePerfect window.

• Scanner Selection and Settings (→P. 15) : Describes scanner selection and setup procedures.

• About Saving Image Files (→P. 16) : Describes the file types that can be saved by CapturePerfect.

• About File Naming (→P. 25) : Describes the requirements of file names for files to be saved by 
CapturePerfect.

• About MultiStream Functions (→P. 30) : Describes the MultiStream output functions.

• About OCR Functions (→P. 33) : Describes the OCR functions.

• About Log Files (→P. 36) : Describes how to save recognition results to a log file when using the barcode 
detection function or OCR function.

• About Barcode/OCR Modification (→P. 38) : Describes how to verify and edit the log files in which 
barcode and OCR recognition results are saved.

• About Other Functions (→P. 39) : Describes saving rotated images, saving split pages and capacity 
warning settings for folders specified as save destinations.

 

Important
• Confirm that your scanner is properly connected to the computer. Refer to your scanner's operating 

manual for details.

• Before using CapturePerfect, install the ISIS/TWAIN driver for the scanner. Refer to your scanner's 
operating manual for ISIS/TWAIN driver installation.
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About the CapturePerfect Window

The following window appears when CapturePerfect launches. The items in the window's menu and status 
bar are described here.

File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

File menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

Open
Opens saved image files. The following file types saved by CapturePerfect can be opened: TIFF (*.tif), 
JPEG (*.jpg), BMP (*.bmp) and PDF (*.pdf) files. Opening an Image File (→P. 72) 
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Save
This procedure saves open image files.

Note
If security is enabled for a PDF file, you are required to enter a password to open the file. Setting PDF 
File Security Options (→P. 83) 

Save As
This procedure saves open image files with a specified name. Saving an Image (→P. 70) 

Close
Closes the open image file.

Close All the Files
Closes all open image files.

Image Info...
Displays information about the open image file.

Print
Prints the image displayed in the window. Printing an Image (→P. 74) 

Print Format
Selects an image size for printing from the submenu.

• Actual Size
Regardless of the printing paper size or scan resolution, the image prints at the same size as the 
original document.

• Fit to Paper
Reduces or enlarges images so they fit the size of the paper, and then prints.

• Actual Pixel
The image is printed so that one image pixel corresponds to one printer pixel. So the size of the 
printed image is smaller when printing to a high resolution printer with small dots.

Printer Setting
Configure printer settings for printing images.

Exit
Exits CapturePerfect.
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Scan menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

Select Scanner
Selects the scanner to be used. Scanner Selection (→P. 15) 

Scanner Setting or  button
Sets up the scanner. Scanner Settings (→P. 15) 

Scan Page
Scans and displays a single document page. Scan Page (→P. 47) 

Scan Batch to File or  button
Continuously scans multiple pages of a document and simultaneously saves the page images to a file or 
files. Scan Batch to File (Saves scanned images to a specified file) (→P. 48) 

Scan Batch to Printer
Prints the images as documents are scanned. Select whether or not to save scanned images when 
Scan Batch to Printer finishes. Scan Batch to Printer (Prints scanned images) (→P. 51) 

Scan Batch to Mail or  button
Attaches scanned images to an email. Select whether or not to save scanned images when Scan Batch 
to Mail finishes. Scan Batch to Mail (Attaches scanned images to email) (→P. 53) 

Scan Batch to SharePoint
Sends scanned images to a SharePoint server. Select whether or not to save scanned images when 
Scan Batch to SharePoint finishes. Scan Batch to SharePoint (Sends scanned images to SharePoint 
server) (→P. 56) 
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Scan Batch To Presentation
CapturePerfect switches to full-screen display before scanning. Select whether or not to save scanned 
images when Scan Batch To Presentation finishes. Scan Batch to Presentation (Displays scanned 
images full-screen) (→P. 59) 

Note
In an environment with a projector connected to the computer, such as a presentation meeting, paper 
documents can be scanned and instantly projected onto the screen for description.

Select Job or  button

Select a job title from  in the tool bar (the Job list box) and click  to execute 

the job. You can select the job title by selecting Create/Delete Job in the Scan menu. Job (Scan 
According to a Previously Registered Job) (→P. 62) 

Create/Delete Job
You can create, edit, or delete the job. Job (Scan According to a Previously Registered Job) (→P. 62) 

Cancel Scan
Interrupts the current scanning operation.

Edit menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

Undo
After performing a page operation (delete, insert/add or replace), undoes the change to revert to the 
previous state.

Redo
Executes the operation that was last undone.
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Brightness
Displays the Brightness dialog box for adjusting brightness and contrast of the displayed image. 
Adjusting Brightness of the Displayed Image (→P. 76) 

Rotate Left or  button
Rotates the page image(s) specified in the submenu counterclockwise.

Rotate Right or  button
Rotates the page image(s) specified in the submenu clockwise.

Copy
Copies the images selected by Select All or in the area specified by Pointer - Select the rectangle to the 
clipboard.
Images copied to the clipboard can be pasted into other applications.

Select All
Selects all parts of the displayed image.

Pointer
Changes the pointer setting from the submenu when selecting a part of the displayed image area.

• Hand
The cursor changes to a hand shape when moving it over an image displayed in the image window. 
When the image is magnified, the displayed area of the image can be moved by dragging.

• Select the rectangle
The cursor changes to a crosshair when moving it over an image displayed in the image window. By 
dragging the crosshair cursor diagonally, the area dragged over is selected.

Password Settings
These settings determine password security when opening PDF files. Setting PDF File Security Options 
(→P. 83) 
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Delete Password
When a PDF file with password security has been opened, this allows removing the security settings. 
Canceling Security (→P. 84) 

Modify Barcode/OCR
Activated when an image file is open, this option displays the Modify Barcode/OCR dialog box for 
modifying the barcode or OCR recognition results. About Barcode/OCR Modification (→P. 38) 

View menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

Toolbar
Switches display of the toolbar on and off.

Statusbar
Switches the Status Bar (→P. 14)  on and off.

Zoom In or  button
Magnifies the view of the image.
Each time you select Zoom In in the View menu or click the Zoom In button, the view of the image is 
magnified (Maximum 400%).

Zoom Out or  button
Reduces the view of the image.
Each time you select Zoom Out in the View menu or click the Zoom Out button, the view of the image is 
reduced (Minimum 10%).

Best Fit or  button
Resizes the view of an image so that it all fits in the current window.
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Fit to Width or  button
Resizes the view of an image so that its width fits the current window.

One To One
Displays each image pixel as one pixel on the monitor. The image's actual displayed size depends on 
the monitor size and resolution.

Split View
Splits the image display window into two or four screens. Split View (→P. 68) 

Thumbnail
By opening the thumbnail window, open images can be viewed at reduced (thumbnail) size. Displaying 
the Thumbnail Window (→P. 67) 

Full Screen
Displays the open image on the full screen. With full screen display, the display status can be changed 
from the submenu displayed by the right mouse button. Scan Batch to Presentation (Displays scanned 
images full-screen) (→P. 59) 

Page menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

Next page or  button
Displays the image of the next page.

Prev. page or  button
Displays the image of the previous page.

Last page
Displays the image of the last page.
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First page
Displays the image of the first page.

Goto page
Displays the image on a specified page.

Delete Page
Deletes the open page.

Insert/Add pages
Inserts or adds a page to the open image file.
Added pages are read from the scanner or selected from existing files. Inserting/Adding Pages to an 
Image File (→P. 77) 

Replace Page
Replaces a page in the open image file.
Replacement pages are read from the scanner or selected from existing files. Replacing a Page in an 
Image File (→P. 80) 

Help menu
File menu   Scan menu   Edit menu   View menu   Page menu   Help   Status Bar

About
Shows CapturePerfect version information.

Help or  button
Shows this Help for CapturePerfect.

Initialize
Selecting OK initializes all of setting values of CapturePerfect.
If you select OK with the Job can be initialized check box selected, all jobs except factory preset ones 
are initialized.
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Status Bar
File menu   Scan menu   Edit menu   View menu   Page menu   Help menu   Status Bar

The image's display zoom (%), page number and scanner settings (mode, resolution and paper size) are 
displayed on the Status bar. 

Note
When CapturePerfect starts, the Status bar is displayed as "---".
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Scanner Selection and Settings

Scanner Selection
Before using CapturePerfect, follow the procedure below to select a scanner to use with it. The selected 
scanner setting is retained until another scanner is selected.

Important
Verify that your scanner is properly connected to the computer, and that the scanner and computer are both 
turned on. Refer to your scanner's operating manual for details.

1 Click Select Scanner in the Scan menu.
The Select Scanner dialog box appears.

Note
If the name of the scanner does not appear in the dialog box, install the ISIS/TWAIN driver for the 
scanner.

2 Select the scanner to be used, and click the OK button.
The Select Scanner dialog box closes and scanner selection is complete.

Scanner Settings
Before scanning a document, set up the scan settings. Settings remain in effect until changed.

1 Click Scanner Setting in the Scan menu, or click the  button.
The scanner setting dialog box appears.

Note
• The settings dialog box displayed depends on your scanner model.

• Scanner settings can be made in the settings dialog box while scanning. Scanning Methods (→P. 46) 

• In case of using the Long Document mode, some functions may be restricted.

2 Make the appropriate settings for your scanning conditions.
For help related to these settings, click the Help button in the dialog box to refer to the driver help.

3 Click the OK button to exit the settings dialog.
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About Saving Image Files

Image file types, file name requirements and multi-page files that can be saved with CapturePerfect are 
described here.

About File Types
Images scanned with CapturePerfect can be saved as TIFF (*.tif), BMP (*.bmp), JPEG (*.jpg), PDF (*.pdf), 
or PowerPoint (* .pptx) files. However, please note that the JPEG file type can be selected only when the 
specified scanning mode is 256-level Gray, 24-bit Color, or Detect Color or Binary Image.

Note
• The available scanning modes will differ depending on the scanner. 

• When the file type is JPEG File (*.jpg), the image quality set by the Details of File Settings is applied. 
Refer to Setting JPEG Compression (→P. 21)  for details.

• When JPEG File (*.jpg) is selected as the file type with Detect Color or Binary Image as the scanning 
mode, black and white images are saved as TIFF files using CCITT Group 4 compression, regardless of 
the current TIFF file compression settings in the Options menu. Color images are saved as JPEG files 
using the image quality settings by the Details of File Settings.

• When the file type is PDF File (*.pdf), the compression ratio set by the Details of File Settings is applied. 
Refer to Setting PDF File Saving Options (→P. 19)  for details.

File Type Settings
The following file-type-dependent settings are available. Settings are made by selecting the file type from 
the Details of File Settings.

Scanning Mode File types that can be saved
TIFF BMP PDF JPEG PowerPoint

Black and White Yes Yes Yes No No
Error Diffusion Yes Yes Yes No No
Text Enhanced Yes Yes Yes No No
Advanced Text Enhancement Yes Yes Yes No No
Advanced Text Enhancement II Yes Yes Yes No No
High Speed Text Enhancement Yes Yes Yes No No
256-level Gray Yes Yes Yes Yes Yes
24-bit Color Yes Yes Yes Yes Yes
Detect Color or Binary Image Yes Yes Yes Yes No



17

Setting TIFF File Compression Options
When TIFF file (*.tif) is selected for the file type in Save As dialog box, the compression format specified 
here is applied.

1 Select TIFF tab in the Details of File Settings.

Note
Details of File Settings appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 

• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

2 Make the following settings:
• Compression

Select the compression format from the list box.
CCITT Group 4 can be selected when the image type is black and white, and OLD JPEG(6) or 
JPEG(7) can be selected when the image type is grayscale or color. If compression is set to None, 
saved files may be quite large.
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Note
• CCITT Group 4

This compression format is used by faxes and other such devices for data transmission, and is used 
to compress black and white images.

• OLD JPEG(6) and JPEG(7)
These compression formats are for saving grayscale and color images. When OLD JPEG(6) or 
JPEG(7) is selected, the value set in the JPEG compression dialog box is applied.

Important
• OLD JPEG(6) is the JPEG format supported by Image Viewer that was bundled with Windows prior to 

Windows 2000, and is no longer supported by the Windows Image and Fax Viewer bundled with 
Windows XP.

• JPEG(7) is not supported by Image Viewer that was bundled with Windows prior to Windows 2000.

• The compression format supported by CapturePerfect may not be supported by other applications. If 
a TIFF file saved by CapturePerfect cannot be opened by another application, set the compression to 
None and save it again.

• JPEG compression
Select the image quality to be applied when OLD JPEG(6) or JPEG(7) is selected under the 
Compression settings. Setting JPEG Compression (→P. 21) 

3 Click the OK button.
The Details of File Settings dialog box closes.
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Setting PDF File Saving Options
When saving scanned images as PDF (*.pdf) files, set the compression and OCR object language saving 
options.

1 Select PDF tab in the Details of File Settings.

Note
Details of File Settings appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 

• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

2 Make the following settings:
• Create PDF/A file

When this check box is selected, PDF/A file is created. Mode is fixed to Standard. If Japanese, 
Japanese and English, Simplified Chinese, Traditional Chinese or Turkish is selected for Language 
for OCR, you cannot create a PDF/A file.

• Mode
Select the PDF file compression ratio.

– High Compression
Files are saved with high compression. Image quality is degraded, but the file size is smaller.

– Standard
Files are saved with standard compression.
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– Character Precedence
To prevent character legibility from degrading, only non-character areas are compressed when files 
are saved.

Note
The Mode setting is only valid when the specified scanning mode is 256-level Gray or 24-bit Color, or 
when a color document is detected with Detect Color or Binary Image as the scanning mode. If the 
scanning mode is a two-color mode such as Black and White, or Error Diffusion, the size of the file 
depends on the size of the document.

• Apply OCR
Select this check box to cause printed characters in the image to be recognized and saved as text 
data attached to the recognized area.

• Language for OCR
When the Apply OCR check box is selected, you can select from the list box the language of the text 
to be scanned.

• Detect in high-precision 
This setting is enabled only when the Apply OCR check box is selected. When this check box is 
selected, high-precision detection is enabled, allowing recognition of outlined letters in the image for 
the language assigned in Language for OCR.

Note
– For PDF files (*.pdf) with attached OCR information, document character strings scanned as 

images are recognized as text and saved as text data.

– When the Apply OCR check box is selected, deskewing is performed regardless of the scanner 
driver's Deskew setting. If you scan sizes smaller than the set scan size or you set the TWAIN driver 
Margin to a large value, the image is moved to the upper-left corner.

– Depending on documents, some images may be truncated if the Apply OCR box is selected. If this 
happens clear the Apply OCR check box.

– In case of using the Long Document mode etc., OCR recognition results may not be applied.

• Hi-speed transfer
Hi-speed transfer can be enabled if your scanner supports JPEG transfers. This option may not be 
displayed or available depending on the scanner you select.
When the scanning mode specified during scanner setup is 256-level Gray or 24-bit Color, this feature 
applies JPEG compression to images transferred from the scanner to the computer.

• JPEG compression
Selects the image quality when Hi-speed transfer is selected. Setting JPEG Compression (→P. 21) 

3 Click the OK button.
The Details of File Settings dialog box closes.
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Setting JPEG Compression 
Select the image quality to be applied when saving scanned images as JPEG files, when Hi-speed transfer 
is enabled under the PDF file settings, or when OLD JPEG(6) or JPEG(7) is selected under the TIFF file 
settings. The selected image quality will determine the file size. The setting here interlocks with the scanner 
setting.

1 Select JPEG tab in the Details of File Settings.

Note
Details of File Settings appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 

• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

2 Make the following settings:
Quality
Select the quality of files to be saved from the following choices. The slider position changes when an 
item is selected from the list box.

Quality Setting Slider Value Image Quality File Size
High Quality 90 (Auto) High Large
Standard 75 (Auto) Standard Standard
High Compression 10 (Auto) Low Small
User Manual setting See Note See Note
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Note
When High Quality is selected, the quality of saved images has priority, but files are large. When High 
Compression is selected, the size of saved image has priority, but image quality is poorer.

3 Click the OK button.
The Details of File Settings dialog box closes.

Setting PowerPoint File Saving Options
When saving scanned images as PowerPoint (*.pptx) files, set the OCR object language and file format for 
image backup.

Note
• Only when the scanning resolution is set to 300 dpi, you can save the image as PowerPoint file.

• You can select up to A4 for paper size of PowerPoint file. However, if Match original size is selected for 
paper size of the scanner settings, error may be occur even if the document is A4 size.

• If the scanner is set to any scanning mode other than 24-bit Color or 256-level Gray, you cannot save 
scanned images in PowerPoint format.

1 Select POWERPOINT tab in the Details of File Settings.

Note
Details of File Settings appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 
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• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

2 Make the following settings:
• Apply OCR

Select this check box to cause printed characters in the image to be recognized and saved as text 
data attached to the recognized area.

• Language for OCR
When the Apply OCR check box is selected, you can select from the list box the language of the text 
to be scanned.

Note
– For PowerPoint files (*.pptx) with attached OCR information, document character strings scanned 

as images are recognized as text and saved as text data.

– When the Apply OCR check box is selected, deskewing is performed regardless of the scanner 
driver's Deskew setting. If you scan sizes smaller than the set scan size or you set the TWAIN driver 
Margin to a large value, the image is moved to the upper-left corner.

– Depending on documents, some images may be truncated if the Apply OCR box is selected. If this 
happens clear the Apply OCR check box.

• Back up image
When selected, creates the backup image file in addition to the PowerPoint file.

• File Type
When Back up image is selected, selects the type of backup image file (TIFF, BMP, PDF, JPEG). 
However, JPEG is available when the Image Format is set to 256-level Gray or 24-bit Color.
If both of the following conditions are satisfied, the error message is displayed during scanning.

– BMP or JPEG is specified for back up image

– Multi Page (All Pages) or Multi Page (Specified Pages) is selected for MultiPage Settings.

• Hi-speed transfer
Hi-speed transfer can be enabled if your scanner supports JPEG transfers. This option may not be 
displayed or available depending on the scanner you select.
When the scanning mode specified during scanner setup is 256-level Gray or 24-bit Color, this feature 
applies JPEG compression to images transferred from the scanner to the computer.

3 Click the OK button.
The Details of File Settings dialog box closes.

About Multi-Page Files
When scanning with Scan Batch to File  (→P. 48) , Scan Batch to Mail  (→P. 53) , or Scan Batch to 
SharePoint  (→P. 56)  and when performing Save Open Image  (→P. 70) , the Multi Page function can be 
used to save multiple images to one TIFF or PDF file.
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MultiPage Settings
MultiPage settings are made from a settings dialog box when Scan Batch to File  (→P. 48) , Scan Batch to 
Mail  (→P. 53) , or Scan Batch to SharePoint  (→P. 56)  is selected for scanning.

Available MultiPage settings are determined by the file type (BMP, JPEG, TIFF, PDF or PowerPoint) 
selected in the scan settings dialog box.

When BMP or JPEG is Selected

Only Single Page is available in the list box, and one image is saved per file. Besides, scanning information 
can be included in the specified File Name by enabling Use Schema. About Schema (→P. 25) 

When TIFF, PDF, or PowerPoint is Selected

• Single Page
Multiple scanned page images are saved as one image per file.

• Multi Page (All Pages)
All scanned page images are saved as one multi-page file.

• Multi Page (Specified Pages)
Page Number is enabled, and multiple scanned page images are saved to multiple multi-page files, each 
with the specified number of pages.

When Multi Page (All Pages) or Multi Page (Specified Pages) is displayed in the list box, multiple page 
images can be saved in one file. 

Note
When Multi Page (Specified Pages) is selected, page images are saved to multiple multi-page files, divided 
according to the number of pages specified in the Page Number field. Also, the batch separation type 
specified in the Scan Batch to File  (→P. 48)  dialog box is changed to None.
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About File Naming

Requirements and limitations of file names assigned to images scanned and saved by CapturePerfect are 
described here.

About File Name Settings
After selecting the TIFF, PDF, or PowerPoint file type and specifying Multi Page (All Pages) or Multi Page 
(Specified Pages) as the MultiPage Settings, multiple page images are saved in one file. About Multi-Page 
Files (→P. 23) 

About Schema
These settings are always applied to file/folder names saved when Single Page is selected as the 
MultiPage Settings (→P. 24) . If no Schema settings have been made, a serial number consisting of four 
digits (by default) is added to the specified file name. Example: docs0001.tif 
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File Name Settings
Selecting the check boxes in the Schema dialog box causes the checked information to be automatically 
added to the names of files to be saved.

• The example file name reflects the effects selected by the check boxes.

• When Schema settings are performed with MultiStream settings, "Prim", "Seco", or “Tert” is added to the 
specified file name.

The character strings to be added are as follows for each selected item:

• The Counter check mark cannot be cleared unless one of the following is selected: Barcode, Imprinter/
Addon, OCR, or Date.

• The Barcode, Imprinter/Addon and OCR check boxes cannot be selected at the same time.

• Barcode is valid when supported by the scanner, and when the Barcode Search scanner setting is 
enabled. Up to four recognized barcode results can be added. However, the total number of characters 
added cannot exceed 64.

• Selecting the OCR check box enables OCR recognition and adds the first 64 recognized characters to the 
file name.

• If you use the value for Barcode or OCR, you can specify the way to add detected character strings to the 
file name from the list box.

– Use detected string
Uses the detected strings as the file name. Invalid letters for file name are displayed in underscores.

– Use detected string of the back image if not detected
When no strings are detected, uses the strings detected in previous image. If there is no detected 
strings in the first image, no strings are added.
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– Follow conversion rule
Converts the detected strings following the conversion table made in advance, and creates the file 
name using the converted strings.

– Undetected
When no strings are detected, specifies the strings of up to eight to add to the file name. This option 
is available only when Use detected string is selected.

• Imprinter/Addon is valid when supported by the scanner, adding to the file name first 64 letters of the 
character string that is printed with the imprinter, or the strings added on.

• Date adds the year, month, day, hour, minute, second, and millisecond of scanning as up to 17 digits. You 
can select the date style to add from the list box.

• Scanning Side adds "Fron" or "Back" to the file name to indicate front-side and back-side images, respectively.

• The following character strings are added to the file name when selecting Image Type, Resolution and 
DropOut.

• When performing Detect Color or Binary Image, a conversion example of the detected type is appended. 
• If you select the Insert separator check box, you can insert the separating character you select from the 

list box between the character strings added to the file name. However, you cannot select different 
separating character for each item.

• The Counter item adds a serial counter specified by Digit Number, Start Value and Step Value.
• The counter starts from Start Value. When scanning with the "Add counter value automatically" check box 

is selected, searches in the corresponding folder for the files whose part of names posterior to the counter 
are completely-consistent, detects the biggest number, and adds the next number automatically.

File Name Settings Driver Setting Characters Appended to File Name

Image Type

Black and White Bina
Error Diffusion Erro
Text Enhanced Text
Advanced Text Enhancement ATex
Advanced Text Enhancement II ATx2
High Speed Text Enhancement FTex
256-level Gray Gray
24-bit Color Colo
Detect Color or Binary Image Bina, Colo or Gray

Resolution

100 dpi 100
150 dpi 150
200 dpi 200
240 dpi 240
300 dpi 300
400 dpi 400
600 dpi 600
1200 dpi 1200

Dropout

None None
Drop-out color Red DRed
Drop-out color Green DGre
Drop-out color Blue DBlu
Drop-out color Custom DCus
Red Enhance ERed
Green Enhance EGre
Blue Enhance EBlu
Custom Color Enhance ECus
Color Elimination DCol
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Folder Name Settings
Selecting the check boxes in the Schema dialog box causes the checked information to be automatically 
added to the names of folders to be saved.

• The example folder name reflects the effects selected by the check boxes.
The character strings to be added are as follows for each selected item:

• The Counter check mark cannot be cleared unless one of the following is selected; Barcode, OCR, or 
Date.

• The Barcode and OCR check boxes cannot be selected at the same time.

• Barcode is valid when supported by the scanner, and when the Barcode Search scanner setting is 
enabled. Up to four recognized barcode results can be added. However, the total number of characters 
added cannot exceed 64.

• Selecting the OCR check box enables OCR recognition and adds the first 64 recognized characters to the 
file name.

• If you use the value for Barcode or OCR, you can specify the way to add detected character strings to the 
folder name from the list box.

– Use detected string
Uses the detected strings as the folder name. Invalid letters for folder name are displayed in 
underscores. If you want to use the OCR recognition result for the document with the patch code 
printed as the folder name, use the PATCH T (FILE A).

– Use detected string of the back image if not detected
When no strings are detected, uses the strings detected in previous image. If there is no detected 
strings in the first image, no strings are added.

– Follow conversion rule
Converts the detected strings following the conversion table made in advance, and creates the 
folder name using the converted strings.

– Undetected
When no strings are detected, specifies the strings of up to eight to add to the folder name. This 
option is available only when Use detected string is selected.

• Date adds the year, month, day, hour, minute, second, and millisecond of scanning as up to 17 digits. You 
can select the date style to add from the list box.

• If you select the Insert separator check box, you can insert the separating character you select from the 
list box between the character strings added to the folder name. However, you cannot select different 
separating character for each item.

• The Counter item adds a serial counter specified by Digit Number, Start Value and Step Value.

• The counter starts from Start Value. When scanning with the "Add counter value automatically" check box 
is selected, searches in the corresponding folder for the files whose part of names posterior to the counter 
are completely-consistent, detects the biggest number, and adds the next number automatically.
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Conversion Settings
Converts the detected character string into another string and use it as the file/folder name. You can set the 
rule for converting here.

• If the items checked in Detected string are detected, they are converted into the specified character 
string. You can switch on/off for each item by selecting Check all or Clear all.

• If Create/Edit is selected, you can add character strings to conversion target ones, or you can edit the 
existing character string. Up to 100 strings can be specified. You can delete the registered strings by 
selecting Delete.

• Selecting Import loads the character strings data from the file which is created in predefined format.

• Selecting Export saves the character strings data in predefined format.

About File Name Limitations
The file name for a saved image file together with its folder path name constitute the absolute path name, 
which may not exceed 200 characters. If the file name would cause the absolute path name to exceed 200 
characters, the file cannot be saved with that name.
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About MultiStream Functions

If your scanner supports MultiStream functions, you can scan different types of image data (such as color 
and black and white or grayscale and black and white) at once, and output the different types of image data 
for the front and back of a page.

The MultiStream settings dialog box is available if your scanner supports the MultiStream function, by 
selecting MultiStream tab in the Option dialog box.

Note
MultiStream functions are disabled when Mode is set to Auto Color Detection or when Resolution is set to 
Auto in the scanner settings.

About MultiStream Settings
1 Select MultiStream tab in the Option.

Note
• If MultiStream is valid, settings for file type and multipage saving which are set in tabs except 

MultiStream become invalid.

• Option settings appears by selecting Option in the following screens.

– Scan Batch to File dialog box (→P. 48) 

– Scan Batch to Mail dialog box (→P. 53) 

– Scan Batch to SharePoint dialog box (→P. 56) 

– Insert/Add the pages from the scanner dialog box (→P. 77) 

– Replace the page from the scanner dialog box (→P. 80) 

– Continue Scanning dialog box (→P. 45) 
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2 Make MultiStream output settings.
• Secondary image settings

Select the Use check box to enable secondary image output.

• Set the scanning conditions (Image Type, Resolution and Drop Out Color)
Scan conditions selections depend on the selected scanner. Refer to your scanner's ISIS/TWAIN 
driver help for details.

• File Type
Select the type (TIFF, BMP, PDF or JPEG) for saving files. However, JPEG is displayed when the 
Image Format is set to 256-level Gray or 24-bit Color. About Saving Image Files (→P. 16) 

• Multi Page Settings
Set the Multi Page settings to suit the file type. MultiPage Settings (→P. 24) 

• File name/folder name settings
You can set the rules for creating file/folder names by selecting Use Schema check box. Select 
Schema to display the Schema dialog box. About File Naming (→P. 25) 

3 Click the OK button.
The MultiStream settings dialog box closes.
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Note
• When you use MultiStream, the "Folio", "Skip blank page", "Prescan", "Text Orientation Recognition", and 

"Patch Code (File Separator)" functions are disabled for some scanners.

• In the DR-7080C/DR-7090C scanner's settings, if Feeding Option is set to Standard Feeding, the 
MultiStream output functions are not valid on images scanned from the flatbed. To enable the 
MultiStream output functions on images scanned from the flatbed, select Panel-Feeding in the Feeding 
Option list.

• The setting items for the scanner driver which supports the MultiStream dialog are as follows;

– Stream to sets
Specifies the stream.

– File Type
Select the type (TIFF, BMP, PDF or JPEG) for saving files. However, JPEG is displayed when the 
Color mode is set to 256-level Gray or 24-bit Color. About Saving Image Files (→P. 16) 

– Multi Page Settings
Set the Multi Page settings to suit the file type. MultiPage Settings (→P. 24) 

– Use Schema
You can set the rules for creating file/folder names. About File Naming (→P. 25) 
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About OCR Functions

CapturePerfect provides OCR functions that can recognize characters in scanned images as text 
information. Character recognition is set in the OCR Applied Area tab in the Option dialog box.

Note
• Refer to Setting PDF File Saving Options (→P. 19)  or Setting PowerPoint File Saving Options (→P. 22)  

for settings to add character information to PDF files or PowerPoint files.

• Refer to About Schema (→P. 25)  for Schema settings.

• When both of the above functions are enabled, character recognition is performed twice on each scanned 
image. 

About OCR Settings
1 Select OCR Applied Area tab in the Option.

Note
Option appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 
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• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

• Continue Scanning dialog box (→P. 45) 

2 Select the language of the text to be recognized from the list box.

Note
Chinese character recognition results display correctly only in environments with Chinese fonts installed.

3 To enable high-precision detection and allow recognition of outlined letters in the image, select 
the Detect in high-precision check box. 

4 Enter the area in which to search for text.



35

5 Load one document page on which character recognition is to be performed, and click the 
Preview button.
The scanner scans the document.

Note
• The displayed image size can be changed by the Zoom In and Zoom Out buttons so that characters in 

the image can be compared with recognition results.

• The area for OCR can be changed by dragging the mouse diagonally on the previewed image.

6 Click the OK button to close each dialog box and finish OCR settings.
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About Log Files

The results of recognition performed with the barcode detection function or OCR function can be saved as a 
log file in the CSV format. Log files saving settings can be performed in the Log File tab in the Option dialog 
box.

To save a log file, select both of the Write Barcode Log check box and Write OCR on a log file check box, 
and then specify a destination log file.



37

Note
• The barcode tab is activated when the scanner supports barcode scanning.

• If editing (addition, deletion, replacement) is performed on the image file page for which a log file is saved, 
the corresponding log file is also edited. In this case, depending on the size of the log file, it may take a 
while for editing of the log file to finish.

• You can select Unicode or ANSI from the Character Code list box.
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About Barcode/OCR Modification

The barcode and OCR recognition results are saved in a log file. About Log Files (→P. 36) 

In the Modify Barcode/OCR dialog box, you can display and modify the recognition results stored in a log 
file, as needed.

Note
• Modifications to the recognition results are applied to the log file.

• If the image file is moved to another storage location, the log file becomes invalid and barcode/OCR 
modification cannot be performed.

• Barcode/OCR modification cannot be performed if the Write Barcode Log/Write OCR on a log file check 
box is not selected in the Log File tab in the Option dialog box. About Log Files (→P. 36) 
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About Other Functions

Here, you are informed various settings in the Option dialog box.

Note
Option appears in the following screens.

• Scan Batch to File dialog box (→P. 48) 

• Scan Batch to Mail dialog box (→P. 53) 

• Scan Batch to SharePoint dialog box (→P. 56) 

• Insert/Add the pages from the scanner dialog box (→P. 77) 

• Replace the page from the scanner dialog box (→P. 80) 

• Continue Scanning dialog box (→P. 45) 

CapturePerfect provides the "Save Rotated Image" and "Save As Two Images" functions that save scanned 
images after specified rotation, or after splitting into top and bottom or left and right halves, respectively. 
Select the "Save Rotated Image" or "Save As Two Images" option before scanning so that scanned images 
are processed efficiently. These settings can be performed in the Save Rotated Image tab or Save As Two 
Images tab.

Also, in the Capacity Warning settings, you can specify a folder in which to save scanned images, and 
specify the storage capacity for that folder. The Capacity Warning displays a message at scan start time or 
while scanning if the preset capacity for the specified folder is exceeded. This setting can be performed in 
the Capacity Warning tab.

Besides, there are other settings; batch separation setting in the Separator tab File Separator Settings 
(→P. 43)  and settings about the behavior during scanning in the Others tab Other Settings (→P. 45) .
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Save Rotated Image
Save Rotated Image   Save As Two Images    Capacity Warning Settings    File Separator Settings    Other Settings 

The Save Rotated Image function rotates scanned images 90 degrees counterclockwise (left) or clockwise 
(right) before saving.

1 Select Save Rotated Image tab in the Option.

2 Select the rotation direction.
Rotate Left 90°: Scanned images are rotated 90° counterclockwise before saving.
Rotate Right 90°: Scanned images are rotated 90° clockwise before saving.
Rotate 180°: Scanned images are rotated 180° before saving.

3 Select two-sided mode and click the OK button.
Book mode: Scans the document with top and bottom directed the same in both sides.
Calendar mode: Scans the document with top and bottom directed inversely in both sides. Scanned 
image of the back side is rotated 180° and saved.
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Save As Two Images
 Save Rotated Image   Save As Two Images   Capacity Warning Settings    File Separator Settings    Other Settings 

By splitting an image, two separate images are created from each one scanned, by splitting it either 
horizontally or vertically before saving. This is useful for documents containing two pages per image, when 
you want to save them as two images (one page per image).

1 Select Save As Two Images tab in the Option.

2 Select the split orientation.
None: The image is not split when selected.
divide up and down: Splits the scanned image horizontally into two separate images.
divide right and left: Splits the scanned image vertically into two separate images.

Note
When saving split images, the names of the single-page files are applied in the order top-bottom or left-
right.
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Capacity Warning Settings
 Save Rotated Image    Save As Two Images   Capacity Warning Settings   File Separator Settings    Other Settings 

After specifying the folder in which to save image files, the storage capacity of that folder can be specified 
for Capacity Warning. A warning message then appears when starting to scan (or while scanning) if the 
cumulative file size would exceed the specified capacity.

1 Select Capacity Warning tab in the Option and click the Create/Edit button.
The Capacity Warning dialog box appears.

2 Specify which folder to monitor.

3 Enter the warning threshold (MB).

4 Click the OK button to close the Capacity Warning dialog box.

Note
• When capacity warning is enabled and the total size of files in the specified folder would exceed the 

specified threshold, the warning message appears when starting to scan (or while scanning), regardless 
of scanning method.

• Files that are not normally displayed, such as hidden and system files, are not included in the capacity 
warning threshold calculation (nor are folders).

• A maximum of 10 folders can be specified for capacity warning.

• When a warning is displayed, follow the message instructions to continue or change the save destination.
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File Separator Settings
 Save Rotated Image    Save As Two Images    Capacity Warning Settings   File Separator Settings   Other Settings 
When scanning multiple pages, you can set how to separate the file or location to separate.

1 Select Separator tab in the Option.

2 Make the following settings;
Record the paper separated file: When selected, saves the patch code sheet or barcode sheet. 
However, if the detected patch code is patchII, the sheet is saved regardless this item is checked or not. 
Create folder: When selected, creates a folder if the file is separated by the barcode. However, if Single 
Page is selected for Multi Page Settings, a folder is always created.
Add to existing file: When selected, adds to existing file. If not selected, adds the counter value 
automatically and created a file with different name. (Only when the following conditions are satisfied)

– Multi Page (All Pages) or Multi Page (Specified Pages) is selected for MultiPage Settings.

– The file is separated by the barcode

– Barcode is selected for Use following values in the Schema settings.

If the following type of document is scanned, for example, batch separation will occur as follows depending 
on the MultiPage Settings option selected in the Scan Batch to File dialog box. 

Barcode string: January, February, March, and January barcodes inserted in order, every 2 pages

File name: imageXXXX

File format: TIFF
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When MultiPage Settings is set to Single Page
Folders named after the barcode strings are created, regardless of the "Create folder" setting. 

If Add to existing file is selected, the page separated by the same barcode is added to the same file and 
saved. If not, the scanned image separated by the second appearence of a given barcode is overwritten or 
saved with counter value added following the file name rules.

Note
• If more than one barcode is detected on a single page, all of the barcode strings will be used in the file 

name, starting with the barcode that is closest to the top left corner of the page and with each barcode 
string separated by a space. 

• When Multi Page scan is performed while "Add to existing file" is enabled, and the file name that the 
scanned images will be saved under already exists, the scanned images will be added to the existing file. 
For instance, if an "imageJanuary.tif" file already exists in the example above, scanned images separated 
by the "January" barcode will be added to that existing file. 

When MultiPage Settings is set to Multi Page (Specified Pages)
Saves the scanned multipage images as the files separated for the numbers entered in Page Number. If 
you select this item, batch separation setting becomes automatically None.
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Other Settings
 Save Rotated Image    Save As Two Images    Capacity Warning Settings    File Separator Settings   Other Settings
You can set the behavior during scanning.

1 Select Others tab in the Option.

2 Make the following settings;
Creates scanning file to Temp folder.: When selected, files under scanning are created in the Temp 
folder. After scanning and creating of the files, the files are copied to the specified folder.
Displays the Continue Scanning dialog box: When selected, displays the Continue Scanning dialog 
box after scanning and specifies whether to scan serial documents or not. However, during Scan Batch 
to Printer, Replace the page from the scanner, and creating PowerPoint files, the dialog box cannot be 
displayed even if you select this setting item.
Give priority to scanning speed: When selected, enhances the scanning speed by roughen the 
preview image during scanning.
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Scanning Methods

The following scanning methods are available with CapturePerfect. Select the scanning method as 
occasion demands.

• Scan Page (→P. 47) : Scans a document to a single page image. The scanned image can be saved or 
printed as needed.

• Scan Batch to File (→P. 48)  : Scanned images are saved to the files specified when starting to scan.

• Scan Batch to Printer (→P. 51)  : Scanned images are printed directly to the specified printer. (Scanned 
images are saved after printing.)

• Scan Batch to Mail (→P. 53)  : Attaches scanned images to an email. (Scanned images are saved after 
sending the mail.)

• Scan Batch to SharePoint (→P. 56) : Sends scanned images to a SharePoint server. (Scanned images 
are saved after sending to the SharePoint server.)

• Scan Batch to Presentation (→P. 59) : Scans with the CapturePerfect window set for full-screen display, 
and retains full-screen display of scanned images. Scanned images are saved when you Scan Batch to 
Presentation.

• Job (→P. 62) : Scanning conditions and post-scan processing are registered beforehand as a job, so that 
scanning is performed according to the registered job settings. Jobs are executed from the tool bar.
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Scan Page

Scan Page scans one page of a document. You can save or print the scanned image as needed. Saving an 
Image (→P. 70) ,  Printing an Image (→P. 74) 

1 Select Scanner Setting in the Scan menu or click the  button to open the scanner's setup 
dialog box.

2 Set the scan criteria and click the OK button.
For help related to these settings, click the Help button in the dialog box to see the driver help.

3 Place a document in the scanner. Refer to the scanner's operating manual for details about 
placing documents for scanning.

4 Click Scan Page in the Scan menu.
One page is scanned, its image is displayed, and processing ends.
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Scan Batch to File (Saves scanned images to a specified file)

Scan Batch to File saves scanned images to a file or files with a name and type specified before scanning.

Scan Batch to File is performed by the following steps:

1 Click the  button, or click Scan Batch to File in the Scan menu.
The Scan Batch to File dialog box appears.

2 Select the file name and file type to be created.

Note
If the scanner is set to any scanning Mode other than 24-bit Color or 256-level Gray, you cannot save 
scanned images in JPEG format. About File Types (→P. 16) 

3 Select Details of File Settings and set details for each type of file to save. File Type Settings 
(→P. 16) 

4 Click the Scanner Setting button, and configure scan settings. Scan Condition Settings (→P. 15) 

Note
You can configure batch separation settings from the scan conditon settings. 
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5 When performing batch separation, configure the "Batch Separator". 
• The "Batch Separator" settings are the same as those found in the scanner settings dialog box.

– If your scanner supports reading barcodes, you can select Barcode in addition to the setting value 
for Batch Separation of the scanner. When you select this item, the batch is separated when the 
barcode is detected.

– If your scanner supports reading patch codes, you can select Patchcode in addition to the setting 
value for Batch Separation of the scanner. When you select this item, the batch is separated when 
the patchcode is detected.

– When you select Automatic Feeding for feeding option of the scanner setting, you can select Auto in 
addition to the setting value for Batch Separation of the scanner. When you select this item, 
scanning continues as the batch is separated for each batch of documents.

– When you select Panel-Feeding for feeding option of the scanner setting, you can select Panel in 
addition to the setting value for Batch Separation of the scanner. When you select this item, the 
batch is separated when you press the batch separation button on the scan panel.

6 Select the item for MultiPage Settings. MultiPage Settings (→P. 24) 

7 If you want to set the name of the saved file/folder, select Scheme and set the rule. About 
Schema (→P. 25) 

8 Set the other settings to suit the documents to be scanned. About Other Functions (→P. 39) 

9 Place a document in the scanner. Refer to the operating manual of the scanner for details about 
placing documents for scanning.

10 Click the Save button.
The documents are scanned.

When no documents remain in the scanner, scanning is interrupted and the Continue Scanning dialog 
box appears.

Note
• If you select "* .pptx" as the saving format, Continue Scanning dialog box is not displayed.

• If the specified file name is the same as that of an existing file, a dialog box prompts to confirm 
overwriting the existing file. Click the OK button to overwrite the file.

• When "Displays the Continue Scanning dialog box" is disabled (a check mark does not appear in front 
of it) in Others tab in the Option dialog box, the scan procedure ends when no documents remain in 
the scanner. Other Settings (→P. 45) 
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11 To continue scanning, load more documents in the scanner and click Continue Scanning. When 
finished scanning, click the Cancel Scan button.
If you select "* .pptx" as the saving format, the application associated with "* .pptx" is activated after 
scanning.
On CapturePerfect, the image whose format is specified in Back up image. Setting PowerPoint File 
Saving Options (→P. 22) 
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Scan Batch to Printer (Prints scanned images)

With Scan Batch to Printer scanning, scanned images are printed directly to the specified printer. (Scanned 
images are saved after printing.)

Scan Batch to Printer is performed by the following steps:

1 Select Print Format in the File menu, and select a format.
• Actual Size

Regardless of the printing paper size or scan resolution, the image prints at the same size as the 
original document.

• Fit to Paper
Reduces or enlarges images so they fit the size of the paper, and then prints.

• Actual Pixel
The image is printed so that one image pixel corresponds to one printer pixel. So the size of the 
printed image is smaller when printing to a high resolution printer with small dots.

2 Click Scan Batch to Printer in the Scan menu.
The Scan Batch to Print dialog box appears.

3 Click Printer Setting to select the printer to use.
The Print dialog box appears.
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Note
To set printer details, click the Properties button. The dialog box for the current printer driver appears. 
For details about settings, refer to the user's manual for your printer driver.

4 Click Scanner Setting and set the scan conditions.
For help related to these settings, press the Help button in the dialog box to see the driver help.

5 Place a document in the scanner.

6 Click OK.
Scanning begins, and soon afterwards, printing of the scanned image begins.
After printing, the message asking whether to save the image or not. Clicking Yes button saves the 
image.
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Scan Batch to Mail (Attaches scanned images to email)

Scan Batch to Mail attaches scanned images to email for sending. (Scanned images are saved after 
sending the mail.)

Note
• To use Scan Batch to Mail, a MAPI (Microsoft Messaging Application Programming Interface) -compliant 

email application program must be installed on the computer.

• Before using this operation, the e-mail software must be set to start by selecting it as follows; Start menu 
- Control Panel - Network and Internet - Internet Options - Programs tab - Set programs of Internet 
programs. (This example is for Windows 7: please follow the corresponding procedure for your operating 
system.)

Use the following procedure to attach scanned images to email for sending:

1 Click the  button, or click Scan Batch to Mail in the Scan menu.
The Scan Batch to Mail dialog box appears.

2 Select the file name and file type to be attached.

Note
• If the scanner is set to any scanning mode other than 24-bit Color or 256-level Gray and  "jpg" or 

"pptx" is selected for file type, error may occur while scanning. About File Types (→P. 16) 

• Only when the scanning resolution is set to 300 dpi, you can save the image as PowerPoint file.

• You can select up to A4 for paper size of PowerPoint file. However, if Match original size is selected 
for paper size of the scanner settings, error may be occur even if the document is A4 size.

• If the scanner is set to any scanning mode other than 24-bit Color or 256-level Gray, you cannot save 
scanned images in PowerPoint format.

3 Select Details of File Settings and set details for each type of file to save. File Type Settings 
(→P. 16) 
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4 Click Scanner Setting and set the scan conditions.
For help related to these settings, click the Help button in the dialog box to see the driver help.

5 Select the item for MultiPage Settings. MultiPage Settings (→P. 24) 

6 If you want to set the name of the saved file/folder, select Use Schema and set the rule. About 
Schema (→P. 25) 

7 Set the other settings to suit the documents to be scanned. About Other Functions (→P. 39) 

8 Place a document in the scanner. Refer to the operating manual of the scanner for details about 
placing documents for scanning.

9 Click the OK button.
The documents are scanned.
When no documents remain in the scanner, scanning is interrupted and the Continue Scanning dialog 
box appears.

Note
• If you select "* .pptx" as the saving format, Continue Scanning dialog box is not displayed.

• When "Displays the Continue Scanning dialog box" is disabled (a check mark does not appear in front 
of it) in Others tab in the Option dialog box, the scan procedure ends when no documents remain in 
the scanner. In this case, skip to step 11.

10 To continue scanning, load more documents in the scanner and click Continue Scanning. When 
finished scanning, click the Cancel Scan button.
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11 When finished scanning, the scanned image files will ready as new e-mail attachments.
The e-mail software starts with the open message that has the attached image files.

Example with Windows Live.

12 Enter the address, subject and message text as needed, and click the Send button to send the e-
mail. Refer to your e-mail software's manual for details of the e-mail sending procedure.
After sending the mail, the message asking whether to save the image or not. Clicking Yes button and 
selecting the saving location save the image.
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Scan Batch to SharePoint (Sends scanned images to 
SharePoint server)

"Scan Batch to SharePoint" sends scanned images to SharePoint server.

Scanned images are saved after all the pages are sent.

1 Click Scan Batch to SharePoint in the Scan menu.
The Scan Batch to SharePoint dialog box appears.

2 Enter SharePoint server URL and account information of destination folder.

3 Click Browse button and select destination folder.

Note
• Entering URL enables Browse button.

• Entering account information, folder name and file name enable OK button.

4 Click Properties setting button and set the file properties.

5 Select file name and file type for a saved image file.

Note
• If the scanner is set to any scanning mode other than 24-bit Color or 256-level Gray, you cannot save 

scanned images in JPEG format. About File Types (→P. 16) 

• Only when the scanning resolution is set to 300 dpi, you can save the image as PowerPoint file.
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• You can select up to A4 for paper size of PowerPoint file. However, if Match original size is selected 
for paper size of the scanner settings, error may be occur even if the document is A4 size.

• If the scanner is set to any scanning mode other than 24-bit Color or 256-level Gray, you cannot save 
scanned images in PowerPoint format.

6 Select Details of File Settings and set details for each type of file to save. File Type Settings 
(→P. 16) 

7 Click Scanner Setting and set the scan conditions.
For help related to these settings, click the Help button in the dialog box to see the driver help.

8 Select Batch Separator. File Separator Settings (→P. 43) 

9 Select MultiPage Settings. MultiPage Settings (→P. 24) 

10 If you want to set the name of the saved file/folder, select Use Schema and set the rule. About 
Schema (→P. 25) 

11 Set the other setting to suit the documents to be scanned. Other Settings (→P. 45) 

12 Place a document in the scanner. Refer to the operating manual of the scanner for details about 
placing documents for scanning.

13 Click the OK button.
Scanning begins, and the scanned images are sent to SharePoint server.
After all pages are sent, upload completed dialog box appears.

14 Click the OK button.
The message asking whether to save the image or not is displayed. Clicking Yes button and selecting 
the saving location save the image.
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Property Settings
You can set the property to the file you send to SharePoint server.

Selecting Properties setting in the Scan Batch to SharePoint dialog box displays the Detail Settings dialog 
box.

This dialog box has following items;

• Check in comment
Enters comments about check-in setting of the file.

• Input of property information when uploading files 
When selected, you can enter the file property information each time you send to SharePoint server.

• Automatic input of property information of files 
When selected, stylized property information is entered automatically each time you send to SharePoint 
server.

• Edit Properties 
Enables to edit the property information automatically entered when Automatic input of property 
information of files is selected.
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Scan Batch to Presentation (Displays scanned images full-
screen)

Scan Batch to Presentation displays a scanned image full-screen. Useful in an environment where the 
computer is connected to a big-screen display or projector, such as for presentations, documents can be 
scanned and displayed as they are described.

Scan Batch to Presentation operates as follows.

Document Scanning
1 Click Scan Batch to Presentation in the Scan menu.

The CapturePerfect window switches to full-screen display when starting Scan Batch to Presentation.

2 Set a document according to the message.
Scan Batch to Presentation operates as follows.

Scan Conditions

Note
• Scan Batch to Presentation scans with the above scanning conditions regardless of ISIS driver settings.

• Depending on the scanner, the above scan conditions may not be supported.

Setting Item Value
Color mode 24-bit Color
Page Size Match original size
Resolution 200 dpi
Scan Sides Skip blank page
Feeding Option Automatic Feeding
Text Orientation Recognition Enabled
Deskew Enabled
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• Actual performance of the "Skip blank page" function is affected by the ISIS driver's "Ratio of black 
pixels" setting. 

3 When the loaded document is finished, scanning stops.

4 To continue scanning, load another document. When finished, click "×" at the top right.
After scanning, the message asking whether to save the image or not. Clicking Yes button saves the image.

Note
You can press the ESC key on the keyboard to exit Scan Batch to Presentation. 

Screen Operations with Full-Screen Display
Screen operations can be performed during full-screen display by right-clicking the mouse and using the 
functions in the submenu that appears, or their assigned shortcut keys.



61

The functions and shortcut keys displayed in the submenu are as follows:

Exit Scan Batch to Presentation
Exit Scan Batch to Presentation mode by pressing the Esc key on the keyboard, or by clicking Exit Scan To 
Presentation on the submenu.

When exiting Scan Batch to Presentation mode, a message asks if you want to save image files. Save the 
image files as occasion demands.

Submenu Shortcut keys
Brightness Ctrl + Shift + B
Fit Window Ctrl + F
Fit Window Width Ctrl + W
Zoom In Ctrl + I
Zoom Out Ctrl + O
Rotate the current page to the left Ctrl + L
Rotate all the pages to the left Ctrl + Shift + L
Rotate the current page to the right Ctrl + R
Rotate all the pages to the right Ctrl + Shift + R
Next Page ENTER
Previous Page BS
Thumbnail Ctrl + T
Exit Scan To Presentation or Exit Full Screen ESC
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Job (Scan According to a Previously Registered Job)

Job utilizes previously registered scan conditions and methods (Scan Batch to File, Scan Batch to Print or 
Scan Batch to Mail) to scan according to the specified job.

Job Registration
Use the following procedure to register jobs for access by Select Job.

1 Select Create/Delete Job in the Scan menu.
The Job dialog box appears.

Note
The following jobs have been registered in advance to 01 and 02.

2 Select a No. to register a job, and click Create/Edit.
The Create/Edit dialog box appears.

No. Title Function
01 Color Document ScanToPC
02 Binary Document ScanToPC
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3 Enter a Title.

Note
Job titles may consist of up to 64 alphanumeric characters.

4 Select a Function from the list box.

• Scan To PC: Scanned images are saved to the specified PC. 

• Scan To Mail: Attaches scanned images to an e-mail.

• Scan To Print: Scanned images are printed by the specified printer.

5 Click Detail Settings.
A setting dialog box appears according to the selected function.

• Scan To PC: Refer to Scan Batch to File  (→P. 48)  for setting details.
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• Scan To Mail: Refer to Scan Batch to Mail  (→P. 53)  for setting details.

• Scan To Print: Refer to Scan Batch to Printer  (→P. 51)  for setting details.

Note
The Details of File Settings button appears in the Scan Batch to File, Scan Batch to Mail, and Scan 
Batch to SharePoint dialog boxes. File Type Settings (→P. 16) 

6 Click the OK button (the Save button for Scan To PC)  to close the settings dialog box.
Registered contents are displayed in the Job dialog box.

7 Click the OK button to close the Create/Edit dialog box.

Note
• Up to 99 jobs can be registered.

• To modify the contents of a registered job, select it and click the Create/Edit button.

• To delete a registered job, click it and then click the Delete button.

• You can use registered jobs in other PC by outputting them into the file. Clicking Export button outputs all 
registered jobs into the file. To import jobs, click Import button and select the file to import. All jobs are 
overwritten by imported jobs.
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Job Execution
1 Register a job by clicking Create/Delete Job in the Scan menu. Job Registration (→P. 62) 

2 Select a job title from the  list box on the tool bar.

Note
• Job titles highlighted in the Job dialog box appear in the list box.

• You can verify the registered contents of the job by selecting Create/Delete Job in the Scan menu. 
You can also verify them by selecting Select Job in the Scan menu, selecting the job title, and then 
selecting Edit.

3 Place a document in the scanner. Refer to the scanner's operating manual for details about 
placing documents for scanning.

4 Click the  button to scan according to the conditions registered for the job.

Note
You can select the job title by selecting Create/Delete Job in the Scan menu.
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Scanned Image Operations

The operations you can perform on scanned or opened images are described here. The way scanned 
images are viewed can be changed, and images can also be saved or printed.

• Displaying the Thumbnail Window (→P. 67) : Displays the thumbnail window.

• Split View (→P. 68) : Split the display window into two or four screens.

• Saving an Image (→P. 70) : Save the displayed image.

• Opening an Image File (→P. 72) : Opens saved images.

• Printing an Image (→P. 74) : Print the displayed image.

• Adjusting Brightness of the Displayed Image (→P. 76) : Adjusts brightness of the open image.

• Inserting/Adding Pages to an Image File (→P. 77) : Adds a page to the open image file.

• Replacing a Page in an Image File (→P. 80) : Replaces a page in the open image with the specified 
image.

• Setting PDF File Security Options (→P. 83) : Sets security to restrict viewing and printing of PDF file.
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Displaying the Thumbnail Window

Thumbnail (reduced) views of opened images are displayed in the Thumbnail window, and the selected 
thumbnail in the Thumbnail window is displayed in the Image View window.

To turn display of the Thumbnail window on and off, click Thumbnail in the View menu.

Note
The thumbnail view state is retained upon closing CapturePerfect, so it will have the same view state when 
next opened.
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Split View

By splitting the display window, you can display multiple page images at once.

To split the display window, select Split View from the View menu. You can split the window into 2 or 4 
screens.

Important
With split view, the size of images you display or the number of screens you display can use a lot of 
memory. If a memory shortage occurs, refrain from using split view.

Note
• Split windows are displayed sequentially from left to right.

• Scanning can be performed with the split view enabled.

• The display method (magnification, reduction and rotation) of each image in the split view can be changed 
independently.

• To return split view to a single image, select Split View from the View menu and specify 1 window.

• The split view state is kept upon closing CapturePerfect, hence the software will open the next time with 
the same view state.

• If CapturePerfect is closed with the Split Screen feature enabled, a message appears warning that a 
memory shortage might occur when CapturePerfect is restarted. Please bear this warning in mind when 
shutting CapturePerfect down with Split Screen enabled.

Splitting the view into 2 or 4 screens
To split the view into 2 or 4 screens, select Split View from the View menu, and specify the number of 
screens in the submenu.
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Two-screen view

Four-screen view
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Saving an Image

This procedure saves open image files with a specified name.

Note
If multiple image files are open, all pages are saved.

Important
• If several image files have been opened and a PDF file with password security is among them, you 

cannot save files with a new name (Save As).

• If there is a PDF file without security setting among some image file opened, you can select only "* .pdf" 
for File Type.

• Even if you open some files including PDF files and there is no PDF file in the range specified in the Page 
Range, you can select only "* .pdf" for File Type.

1 Click Save As in the File menu.
The Save As dialog box appears.
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2 Make the following settings:
• Save in

Select the folder in which to save the file.

• File name
Enter the file name for the image.

• Save as type
Select a file type from TIFF File (*.tif), BMP File (*.bmp), JPEG File (*.jpg) or PDF File (*.pdf). The types 
of files that can be saved depend on the scanning mode specified before scanning. Refer to About 
Saving Image Files (→P. 16) for details.

Note
When scanned, the compression ratio set in the Details of File Settings dialog box is applied. Refer to 
File Type Settings (→P. 16)  for details.

Important
If you select JPEG File (*.jpg) when a black and white image file is open, it is saved as a Grayscale 
Image.

3 When saving a multi-page image file, set the page range to be saved.

Note
For a PDF file with password security, the Current Page and Goto Page options are disabled.

4 When saving a multi-page image file as a single image file, select the Multi-page file check box.

Note
• When the Multi-page file check box is not selected, the image file is divided by page, and a four-digit 

sequential number is appended to each new saved file. However, if the saved image file is only one 
page, the four-digit sequential number is not appended to the file name.

• Only when the saved file type is TIFF or PDF, Multi Page (All pages) check box is available.

5 Click the Save button.
The Save As dialog box closes and the image is saved.

Original image (Black & White) Image saved as a JPEG (Grayscale)
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Opening an Image File

This procedure opens image files that were saved by CapturePerfect.

Note
The following file types saved by CapturePerfect can be opened: TIFF (*.tif), JPEG (*.jpg), BMP (*.bmp) and 
PDF (*.pdf) files.

1 Click Open in the File menu.
The Open dialog box appears.
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2 Select a file and click the Open button.
The selected image file appears on the screen.

Note
Multiple files can be selected to be opened together. By selecting one file and holding the Shift key while 
selecting another file, all files in between are selected. Files can also be selected by holding the Ctrl key 
while selecting each file.
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Printing an Image

The following procedure prints the image displayed in the window:

1 Click Printer Setting on the File menu.
The Print Setup dialog box appears.

2 Select the printer, paper and printing orientation as needed, and click the OK button.

Note
To set printer details, click the Properties button. The dialog box for the current printer driver appears. 
For details about settings, refer to the user's manual for your printer driver.

3 Click Print Format on the File menu, and select the desired print format from the following:
• Actual Size

Regardless of the printing paper size or scan resolution, the image prints at the same size as the 
original document.

• Fit to Paper
Reduces or enlarges images so they fit the size of the paper, and then prints.

• Actual Pixel
The image is printed so that one image pixel corresponds to one printer pixel. So the size of the 
printed image is smaller when printing to a high resolution printer with small dots.
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4 Click Print in the File menu.
The Print dialog box appears.

5 Verify the settings, and click the Print button.
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Adjusting Brightness of the Displayed Image

You can adjust the brightness and contrast of the displayed image.

Select Brightness in the Edit menu to open the Brightness dialog box.

Moving the sliders left and right adjusts the brightness and contrast of the displayed image.

After adjusting, click the OK button.

Note
• For grayscale and color images, the image file can be re-saved with the adjusted brightness.

• For black and white images, brightness can be adjusted if the image is displayed as grayscale (other than 
"100%" display). However, the image cannot be saved with adjusted brightness.

• Brightness can be adjusted for each page.

• When displaying a PDF file, you cannot save the brightness adjustments with the image.
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Inserting/Adding Pages to an Image File

Pages can be inserted and added to TIFF or PDF files.

For the image to insert/add, you can specify an image from the scanner or a file saved with CapturePerfect.

1 Open the TIFF or PDF file in which to insert the page.

Note
• Pages cannot be added to BMP or JPEG files.

• To add a page to an image currently saved as a BMP or JPEG file, first resave the image as a TIFF or 
PDF file.

2 Click Insert/Add pages in the Page menu to open the submenu.

3 Select the source of the image to add or insert.
• from Scanner

Scans the image to add/insert.

• from File
Select the image to add/insert from saved image files.

4 Add/insert a page.
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When "from Scanner" is selected
1) The Insert/Add the pages from the scanner dialog box is displayed.

2) Select the location to add or insert the page, make the Scanner Settings, and click OK.
Scanning begins, and pages are added or inserted.

3) When there are no more documents, scanning stops.

When "from File" is selected
1) The Open dialog box is displayed.
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2) Select the image file to add or insert, and click Open.
The Insert/Add the pages from the file dialog box appears.

3) Select the location to add or insert the page, the image file page to be inserted, and click OK.

5 When finished inserting/adding the page, confirm that the page was added or inserted in the 
specified location.

Note
• To save the image file with added or inserted pages, select Save As or Close from the File menu. 

• When Close is selected, a message appears asking if you want to save the file. Click Yes to overwrite the 
image file.
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Replacing a Page in an Image File

You can replace a page in a saved multi-page TIFF or PDF file. For the replacement image, you can specify 
an image from the scanner or a file saved with CapturePerfect.

1 Open the TIFF or PDF file in which to insert the page.

2 Click Replace Page in the Page menu to display the submenu.

3 Select the source of the image to replace.
• from Scanner

Scans the image to replace.

• from File
Select the image to replace from saved image files.

Note
• When "from Scanner" is selected, pages following the displayed page are replaced by scanned 

images.

• When "from File" is selected, pages following the displayed page are replaced by the selected 
images.
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4 Replace the page.

When "from Scanner" is selected
1) The Replace the page from the scanner dialog box is displayed.

2) Set the Scanner Settings, and click OK.
Scanning begins, and pages following the displayed page are replaced.

3) When there are no more documents, scanning stops.

When "from File" is selected
1) The Open dialog box is displayed.
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2) Select the image file containing the image to be replaced, and click Open.
The Replace the page from the file dialog box appears.

3) Confirm the replacement image(s) in the image file by clicking Next page and Prev. page, specify the 
page range for replacement, and click OK.
Pages following the displayed page are replaced by the image(s) specified for the Page Range. 

5 When finished page replacement, confirm that the image(s) of the specified page(s) are replaced.

Note
• To save the image file with replaced pages, select Save As or Close from the File menu. 

• When Close is selected, a message appears asking if you want to save the file. Click Yes to overwrite the 
image file.
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Setting PDF File Security Options

Set the security options to restrict viewing, printing and page editing of PDF files.

Security Settings
Open a PDF file, and click Password Settings in the Edit menu to open the Password Settings dialog box.

1 Select check boxes to set passwords.
• Password to open document

The Document Open password is required to open the PDF file, and is entered in a dialog box that 
appears when opening the PDF file.

• Password to change authority and password
The Permissions password restricts changing authority to print the file or edit a page, and is entered in 
a dialog box that appears when attempting to change security settings.

Important
Always set the permissions password when setting permissions. If permissions are set only with the 
Document Open password, security can be canceled merely by opening the document, so care should 
be exercised.

Note
When adding, inserting or replacing pages, PDF files which have the user password set cannot be used 
for addition or insertion.

2 Set the password and enter the same password to confirm.
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3 Set the Authority.
• Encryption Level

Select the security encryption level. Available encryptions levels are High 128-bit (RC4) and Low 40-
bit (RC4), with the 40-bit (RC4) level providing weaker security than the 128-bit (RC4) level.

• Forbid users to Print
Prohibits printing of the PDF file.

• Forbid users to Edit
Prohibits page operations (add, insert and replace).

Important
When setting authority, set the Permissions Password to prevent users from canceling security.

4 Click OK to activate security.

Note
Setting or canceling security takes effect regardless of whether the file has been saved.

Canceling Security
When opening a PDF file that has security set, Delete Password is enabled in the Edit menu. To cancel 
security, click Delete Password and following the message instructions.

Note
• The Permissions Password must be entered if it has been set.

• If only the Document Open password has been set, clicking Delete Password displays a confirmation 
message to cancel security. Click OK to cancel security.
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